LENESANS

-
»
b
i
<
Q
S
-
D

RX65N Group

Renesas Starter Kit+
Smart Configurator Tutorial Manual
For CS+

RENESAS 32-Bit MCU
RX Family / RX600 Series

All information contained in these materials, including products and product specifications,
represents information on the product at the time of publication and is subject to change by
Renesas Electronics Corp. without notice. Please review the latest information published by
Renesas Electronics Corp. through various means, including the Renesas Electronics Corp.
website (http://www.renesas.com).

Renesas Electronics
WWW.renesas.com Rev. 1.00 May 2017



10.

11.

12.

Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits,
software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and
damages incurred by you or third parties arising from the use of these circuits, software, or information.

Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving
patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or
technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm,
application examples.

No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas
Electronics or others.

You shall not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas
Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration,
modification, copy or otherwise misappropriation of Renesas Electronics products.

Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended

applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment;
home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication
equipment; key financial terminal systems; safety control equipment; etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life

or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property damages (space and

undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas

Electronics disclaims any and all liability for any damages or losses incurred by you or third parties arising from the use of any Renesas

Electronics product for which the product is not intended by Renesas Electronics.

When using the Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes,
"General Notes for Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are
within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat radiation
characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out
of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please ensure to implement safety measures to guard them
against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of
Renesas Electronics products, such as safety design for hardware and software including but not limited to redundancy, fire control and
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as
warranty for your products/system. Because the evaluation of microcomputer software alone is very difficult and not practical, please
evaluate the safety of the final products or systems manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each
Renesas Electronics product. Please investigate applicable laws and regulations that regulate the inclusion or use of controlled
substances, including without limitation, the EU RoHS Directive carefully and sufficiently and use Renesas Electronics products in
compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses
occurring as a result of your noncompliance with applicable laws and regulations.

Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use,
or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall not use Renesas Electronics products or
technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction,
such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAVs)) for
delivering such weapons, (2) any purpose relating to the development, design, manufacture, or use of conventional weapons, or (3) any
other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics
products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any
other party will engage in the activities described above. When exporting, selling, transferring, etc., Renesas Electronics products or
technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments
of the countries asserting jurisdiction over the parties or transactions.

Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms
and conditions described in this document, including this notice, and hold Renesas Electronics harmless, if such misuse or violation results
from your resale or making Renesas Electronics products available any third party.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or
Renesas Electronics products.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned

subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

(Rev.3.0-1 November 2016)




General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas.
For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well
as any technical updates that have been issued for the products.

1. Handling of Unused Pins

Handle unused pins in accordance with the directions given under Handling of Unused Pins in the

manual.

%, The input pins of CMOS products are generally in the high-impedance state. In operation with an
unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false
recognition of the pin state as an input signal become possible. Unused pins should be handled as
described under Handling of Unused Pins in the manual.

2. Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

%, The states of internal circuits in the LSI are indeterminate and the states of register settings and
pins are undefined at the moment when power is supplied.

In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.
3. Prohibition of Access to Reserved Addresses
Access to reserved addresses is prohibited.

%. The reserved addresses are provided for the possible future expansion of functions. Do not access
these addresses; the correct operation of LSI is not guaranteed if they are accessed.

4. Clock Signals
After applying a reset, only release the reset line after the operating clock signal has become stable.
When switching the clock signal during program execution, wait until the target clock signal has
stabilized.

% When the clock signal is generated with an external resonator (or from an external oscillator)
during a reset, ensure that the reset line is only released after full stabilization of the clock signal.
Moreover, when switching to a clock signal produced with an external resonator (or by an external
oscillator) while program execution is in progress, wait until the target clock signal is stable.

5. Differences between Products

Before changing from one product to another, i.e. to a product with a different part number, confirm

that the change will not lead to problems.

% The characteristics of Microprocessing unit or Microcontroller unit products in the same group but
having a different part number may differ in terms of the internal memory capacity, layout pattern,
and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a
product with a different part number, implement a system-evaluation test for the given product.




Disclaimer

By using this Renesas Starter Kit (RSK+), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Smart Configurator) for RX together with the CS+ IDE to create a working project for the RSK+ platform. It is
intended for users designing sample code on the RSK+ platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK+ platform. Further details regarding
operating the RX65N microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX65N Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.

User's Manual Describes the technical details of the RSK+RX65N-2MB User’s R20UT3888EG
RSK+ hardware. Manual

Tutorial Manual Provides a guide to setting up RSK+ RSK+RX65N-2MB Tutorial R20UT3889EG
environment, running sample code Manual
and debugging programs.

Quick Start Guide Provides simple instructions to setup RSK+RX65N-2MB Quick R20UT3890EG
the RSK+ and run the first sample. Start Guide

Smart Configurator Provides a guide to code generation RSK+RX65N-2MB Smart R20UT3891EG

Tutorial Manual and importing into the CS+ IDE. Configurator Tutorial Manual

Schematics Full detail circuit schematics of the RSK+RX65N-2MB R20UT3887EG
RSK+. Schematics

Hardware Manual Provides technical details of the RX65N Group, RX651 Group | RO1UHO590EJ
RX65N microcontroller. Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
DVD Digital Versatile Disc
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi_s is a Digilent Pmod™ (_Zc_)mpatible connector. Pmod™ s registered to Digilent Inc.
Digilent-Pmod_Interface_Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK+ Renesas Starter Kit+
RTC Real Time Clock
SAU Serial Array Unit
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TAU Timer Array Unit
TFT Thin Film Transistor
TPU Timer Pulse Unit
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


http://www.digilentinc.com/index.cfm
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RSK+RX65N-2MB R20UT3891EG0100
Rev. 1.00
RENESAS STARTER KIT+ May 31, 2017

1. Overview

1.1  Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE
Smart Configurator to create a working project for the RSK+ platform.

1.2 Features

This RSK+ provides an evaluation of the following features:
« Project Creation with CS+

« Code generation using the Smart Configurator.
« User circuitry such as switches, LEDs and a potentiometer

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT3891EG0100 Rev. 1.00 R nNS Page 8 of 69
May 31, 2017 ENES



RSK+RX65N-2MB 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator for the RX family
together with the CS+ IDE to create a working project for the RSK+ platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the Smart Configurator for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
e ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
e ‘Debug’is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options (level two) and no ‘Outputs debugging information’
options not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

R20UT3891EG0100 Rev. 1.00 R nNS Page 9 of 69
May 31, 2017 ENES




RSK+RX65N-2MB 3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX65N
MCU, ready to generate peripheral driver code using Smart Configurator. This project generation step is
necessary to create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:
Windows™ 7: Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)’ icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

e CS+ will show the Start Page. Use the Create New Project
. ’ H A j be ed.
GO bUtton to Crea‘te a NeW PrOJeCt' Agzx ngz:; alsgf:tcreated by reusing the file configuration registered to an existing project.
e In the ‘Create Project’ dialog, select | | createproject X
‘RX" from the ‘Microcontroller’ pull-
d own. Microcontroller: R w
e In the ‘Using Microcontroller’ list Using microcontraller:
control, scroll down to ‘RX65N’ and &84 (Search microcontroller) Update...
eXpand‘ the tree control by C“,Ck,mg +. 3 REFSESNEDFE(144pin) ~ | [ Product Name:REF565NEDXFC
Select ‘R5F565N EDXFC(176p|n) . ¥ RSFSE5NEDKFE_DUAL(144pin) On-chip ROM size[KEytes] 2048
. . . F On-‘;hip RAM size[_E‘yles] 655360
e Ensure that in the ‘Kind of prOJeCt’ pu”- F R5F565NEDFC. DUAL(176gin) Additional Information: Package=PLQP0176KB-A
down, ‘Application(CC-RX)’ is selected. M RSF565NEDxF P(100pin)
i M REFBEENEDxFP_DUAL(100pin)
e Choose an appropriate name and P RSFEESNEDLC(177pin) v
location for the project, then click < T T S
‘Create’.
. . . Kind of project: Application{CC-RX) v
Note: this tutorial assumes the project
is named and located at the place ipiecinane: SC_Tutorial
shown OppOSlte. Flace: C\Workspace ~ Browse...
J !f the f_old’er entered cannot be found a T
Question’ dialog will be displayed, : : - I
click 'Yes'. C:Aworkspace\SC_Tutorial\SC_Tutorial mtpj
[] Pass the file composition of an existing project to the new project
Project to be passed: Browse...
Copy composition files in the diverted project folder to a new project folder.

May 31, 2017




RSK+RX65N-2MB

3. Project Creation with CS+

e CS+ will create the blank project with
the standard project tree. A ‘Smart
Configurator’ node may also be

shown, if previously enabled.

@3 SC_Tutorial - C5+ for CC - [Property]

File Edit View Project Build Debug Tool Window Help

Boat FEAS X D@E[0C HER | 100% iz

i ¢ a;] QS'] @ [y C_g | {‘ Solution List

Project Tree

t @ 8@

1 x

BLﬁ SC Tutorial (Project’
; R3F365MED®FC (Microcontroller)

| jenueyy vewg £

art Configurator (Design Tool)

4, CC-RX (Build Tool)
¢, RX Simulator (Debug Tool)
Program Analyzer (Analyze Tool)

..... f-| iodefine.h
----- n| sbrich
----- b stackset.h

----- "_l typedefine.h
----- "_l wvect.h

| Smart Corfigurator Property

+ Product Information

€rs

R20UT3891EG0100 Rev. 1.00
May 31, 2017
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RSK+RX65N-2MB 4. Smart Configurator Using the CS+

4. Smart Configurator Using the CS+

4.1 Introduction

The Smart Configurator for the RX65N has been used to generate the sample code discussed in this
document. Smart Configurator for CS+ is a tool for generating template ‘C’ source code and project settings
for the RX65N. When using Smart Configurator, it supports user with a visual way of configuring the target
device, clocks, software components, hardware resources and interrupts for the project. Thereby bypassing
the need in most cases to refer to sections of the Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called SC_Tutorial. A fully
completed Tutorial project is contained on the DVD and may be imported into CS+ by following the steps in
the Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. Custom code should be added, whenever possible, in between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK+.

Following a tour of the key user interface features of Smart Configurator and the reader is guided through
each of the peripheral function configuration dialogs in 84.2. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

R20UT3891EG0100 Rev. 1.00 RENESAS Page 12 of 69
May 31, 2017



RSK+RX65N-2MB 4. Smart Configurator Using the CS+

4.2 Project Configuration using Smart Configurator - Overview page

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the Smart Configurator Usage.

You can download the latest document from: https://www.renesas.com/smart-configurator.

Smart Configurator will start up by double clicking on “Smart Configurator(Design Tool)” on the project tree.
The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

@ smart Configurator
File Window Help
e -
¥ SC_Tutorialscfg 52 = O || MCU Package 2 =
ISEENINE -NENIPSRIPE

o5

Overview information

~ General Information

This editer allows you to medify the settings stored in configuration file (:scfg)

Board

Allow board and device selection

Application under
Clacks development
Allow clock configuration

- - Components
Middleware

Device -

0 — | RENESAS

e

Components
Allow software component selection and configuration
~— Pins
Pins RX65N
Allow general pin configuration and pin configuration for selected software component
REFS65NEDXFC
Interrupt

Allow general interrupt configuration and interrupt configuration for selected software component

~ Current Configuration

Selected board/device: RSF565MEDxFC

v
Overview| Board | Clocks| Components| Pins| Interrupts

» Legend
& Console 2

BH 2| # B~ =+ = O ||[£L Configurstion Problems &2
Smart Configurator Qutput 0items
1MB5@A88A1: Pin 24 is assigned to EXTAL Description
MB5@@88@1: Pin 22 is assigned to XTAL

e

Type

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has

configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project that builds and runs without error.

R20UT3891EG0100 Rev. 1.00 RENESAS Page 13 of 69
May 31, 2017
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RSK+RX65N-2MB 4. Smart Configurator Using the CS+

4.3 Clocks configuration page

Clocks configuration page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected to
‘r_bsp_config.h’ file in ‘Smart Configurator\r_config’ of project tree.

4.3.1  Clocks configuration

Figure 4-2 shows a screenshot of Smart Configurator with the Clocks tab. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on-board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-2.

{8} *SC_Tutorial.scfg 32

Clocks configuration

¥ Main clock
Oscillation source: | Resonator >

Frequency: 24 (MHz)

Oscillation wait time:

30848 (us) actual value: 30848.485 us

PLL circuit
Frequency Division:

x1 A

Frequency Multiplication:

x10.0 >

Sub-clock

HQCO clock

SCKCR (FCLK[3:01)

x1/4 =
SCKCR (ICLK[3:0])
x1/2 ~

SCKCR (PCLKA[3:0])
x1/2 4

SCKCR (PCLKB[3:07)
x1/4 w

SCKCR (PCLKC[3:01)
x1/4 4

SCKCR (PCLKD[3:0])
x1/4 e

SCKCR (BCK[3:00)
x1/2 =

SCKCR2 (UCK([3:0)
x1/5 =

BCKCR (BCLKDIV)

LOCO clock

IWDT-dedicated on-chip clock

FlashIF clock (FCLK)
60.0 (MHz)

System clock (ICLK)
120.0 (MHz)

Peripheral module clock (PCLKA)
1200 (MHz)

Peripheral module clock (PCLKB)
60.0 (MHz)

Peripheral module clock (PCLKC)
60.0 (MHz)

Peripheral module clock (PCLKD)
60.0 (MHz)

External bus clock (BCLK)
1200 (MHz)

USB clock (UCLK)
48.0 (MHz)

CANMCLK/CACMCLK
24 (MHz)

Overview |Board| Clocks | Components| Pins| Interrupts

Figure 4-2 Clocks Configuration page
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4.4  Component page

Drivers and middleware are handled as software components in Smart Configurator. Component page allows

user to select and configure software components.
o] *SC_Tutorial.scfg 3

Software component configuration
Components = :%> -

%

type filker text

v [= Startup
~ [= Generic
& rbsp

= Drivers
= Middleware
= Application

Overview | Board C\ocksPins Interrupts
Figure 4-3 Component page

441 Add asoftware component into the project
Smart Configurator supports two types of software components: Code Generator and Firmware Integration

Technology. In the following sub-sections, the reader is guided through the steps to configure the MCU for a
simple project containing interrupts for switch inputs, timers, ADC and a SCI by component of Code Generator.

Click ‘Add component’ & icon.

i,?,:? *SC_Tutorial.scfg &2

Software component configuration

Components = :’.f:p -

type filter text

v (= Startup
W [= Generic

& rbsp
Figure 4-4 Add a Code Generator component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator'.

G Mew Component O X
Software Component Selection
Select component from those available in list 1ﬂj

Function | All ~
Type Code Generator ~
. All
Filter Firmware Integraticn Technolog
Code Generator
Components Type Version o
 8-Bit Timer Code Generator 1.0.0
B Buses Code Generator 1.0.0
B Clock Frequency Accuracy Meas... Code Generator 1.0.0
B Compare Match Timer Code Generator 111 w

Figure 4-5 Add a Code Generator component (2)
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4.4.2  Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as
timers in de-bouncing of switch interrupts.
Select ‘Compare Match Timer’ as shown in Figure 4-6 below then click ‘Next'.

G New Component O X

Software Component Selection

Select component from those available in list

Function |All ~
Type 9 Code Generator ~
Filter |
=

Components Type Version )

% 2-Bit Timer Code Generator 1.00

8 Buses Code Generator 1.00

# Clock Freguency Accuracy Meas...  Code Generator 1.0.0

4 Compare Match Timer Code Generator 1.1.1 {

H% Complementary PWM Mode Timer Code Generator 110

## Continuous Scan Mode 5124D Code Generator 1.00

B2 FOC Caledasns Fodec: 1nn hd

Show only last version

Description

This software compenent provides configurations fer 16-bit/32-bit timer with module
CMT/CMTW and can generate interrupts at set intervals,

Download more software components

Configure general settings...

® < Back I Next > I | Einish | Cancel

Figure 4-6 Select Compare Match Timer

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTQ’ as shown in Figure 4-7

below then click ‘Finish’.

G New Component O X

Add new configuration for selected comp

Compare Match Timer

Configuration name: Config_CMT2 ‘

Resource: CMT2 ~

CMT2
CMTWO
CMT3
CMTW1
CMT1

@ < Back Next > ol

Figure 4-7 Select Resource - CMTO
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4. Smart Configurator Using the CS+

In the ‘Config_CMTOQ’ configures CMTO as shown in Figure 4-8. This timer is configured to generate a high

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

B *SC_Tutorial.scfg 2
Software component configuration
Components = 2 Configure
% = Count clock setting
- @ PCLK/2 (O PCLK/32 (O PCLK/128 (O PCLK/512
type filter text
Compare match setting
v = Startup
v = Generic Interval value I 1 I Ims ~ I(Actual value: 1.000000)
& rbsp Register value (CMCOR) [ 7200 |
~ = Drivers
v (= Timers [~] Enable compare match interrupt (CMIO)
& Config_CMTO Priority
= Middleware
= Application

Figure 4-8 Config_CMTO setting

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT1’ as shown in Figure 4-9 below then click ‘Finish’.

!E New Component O

Add new configuration for selected component

B

Compare Match Timer

x

Canfiguration name: | Config_CMT1

Resource: CMT1

CMTO

CMTZ
CMTWO
CMTW1

Figure 4-9 Select Resource — CMT1

Navigate to the ‘Config_CMT1" and configure CMT1 as shown in Figure 4-10. This timer is configured to
generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in

this tutorial.

i *SC_Tutorial.scfg 2
Software component configuration

Components

=] c- g Configure
s Count clock setting
- O PCLE/E ® PCLK/32 (O PCLK/128 OPCLK/512
type filter text
Compare match setting
w [= Startup
v (= Generic Interval value I 20 I Im; v I(Actua\ value: 20.000000)
f“ r_bsp Register value (CMCOR) 37499
v [= Drivers
v (= Timers Enable compare match interrupt (CMI1)
@ Config CMTO Priority |Leverto iv]
o Config_CMT1
= Middleware
= Application

Figure 4-10 Config_CMT1 setting
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4. Smart Configurator Using the CS+

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-11 below then click ‘Finish’.

!E Mew Component

O X
Add new config for sel d p
Compare Match Timer
Cenfiguration name: Config_CMT2 |

Resource:

@ < Back

Next >

Cancel

Figure 4-11 Select Resource — CMT2

Navigate to the ‘Config_ CMT2’ and configure CMT2 as shown in Figure 4-12. This timer is configured to
generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in

this tutorial.

48k *5C_Tutorial. scfg &2

Components

type filter text

Software component configuration

E

&

=

2o Configure
Count clock setting

OPCLK/S OPCLK/32

w = Startup
w = Generic
& rbsp
~ [= Drivers
w [= Timers
& Config_CMT2
& Config_CMTO
@ Config_CMT1
= Middleware

P Amnlicat

Compare match setting

Interval value
Register value (CMCOR)
Enable compare match interrupt (CMI2)

Priority

(®) PCLK/512

I II'TIS

~ | (Actual value: 200.004267)

Figure 4-12 Config_CMT2 setting
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4. Smart Configurator Using the CS+

4.4.3 Interrupt Controller

Referring to the RSK+ schematic, SW1 is connected to IRQ11(P03) and SW2 is connected to IRQ13 (P05).
SW3 is connected IRQ15(P07) and the ADTRGON. Tutorial used ADTRGONn and will be configured later in

§84.4.7.

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.
Select ‘Interrupt Controller’ as shown in Figure 4-13 then click ‘Next'.

!E MNew Component

Software Component Selection

Select component from those available in list

O X

=5

Function | All v
Type a Code Generator ~
Filter |
Components Type Version @
B 12C Master Mode Code Generator 100
B [2C Slave Mode Code Generator 1.0.0
Interrupt Controller Code Generator 1.2.0 |
B Low Power Consumption Code Generator 1.1.0
# MNormal Mode Timer Code Generator 1.00
Code Generator 12.0 v

B Phace Countina Made Timer
<

Show only last version

Description

interrupt, NM| pin interrupt and IRQ External pin interrupts.

Interrupt Controller configures the interrupt requests generated by [CU: Software

Download more software components

Configure general settings...

@' < Back I Next » I I

FEinish

Cancel

Figure 4-13 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-14

below then click ‘Finish’.

IE MNew Component

Add new configuration for selected component

Interrupt Controller

O X

&

Configuration name: “Can\g_ICU |
Resource: IcU v

Figure 4-14 Select resource — ICU
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4. Smart Configurator Using the CS+

Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-15

below.

8 *§C_Tutorial.scfg &2 I

Software component configuration
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type filter text
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v [= Drivers
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& Config CMT1
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Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)
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No filter
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Figure 4-15 Config_ICU setting
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4.4.4 Ports

Referring to the RSK+ schematic, LEDO is connected to P73, LED1 is connected to PG7, LED2 is connected
to PG6 and LED3 is connected to PG5. PJ3 is used as one of the LCD control lines, together with PF5, PG3
and PG4.

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.
Select ‘Ports’ as shown in Figure 4-16 then click ‘Next'.

6 New Camponent m} x
Software Component Selection
Select component from those available in list tl:r

Function All ~
Type | Code Generator | v
Filter |
=

Components Type Version 2

H# Normal Mode Timer Code Generator 1.00

## Phase Counting Mode Timer Code Generator 120

1 Port Output Enable Code Generator 1.0.0

£ Ports Code Generator 120 |

£ Programmable Pulse Generator  Code Generator 1.0.0

B PWM Mode Timer Code Generator 110

B Real Time Clark rrle Generatar 100 e

< >

Show only last version

Description

This software component provides configurations for General Purpose Input/Qutput.
Commen features such as reading, writing, and setting the direction of ports and
pins can be configured. Enabling features such as open-drain eutputs and internal
pull-ups are also supported,

Download mere software components

Configure general settings...

@' < Back I Mext = I | Finish | Cancel

Figure 4-16 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-17
below then click ‘Finish’.

6 New Component [m| X
Add new configuration for selected component |
Ports
Configuration name: | tonfig,PORT |
Resource: PORT ~

@' < Back Mext = Cancel
Figure 4-17 Select resource — PORT
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‘PORT7’, ‘PORTF’, ‘PORTG’, ‘PORTJ' tick box is checked as shown in Figure 4-18 below.

i,?m,} *SC Tutorial.scfg 32

Software component configuration

‘Components

type filter text

=

-

~ [= Startup
v (= Generic
.f'-' r_bsp
w [= Drivers
v (= Interrupt
& Config_ICU
w [ /O Ports
& Cenfig_PORT
w (= Timers
& Config_CMT2
& Cenfig_CMTO
& Config_CMT1
== Middleware
= Application

Configure

Port selection  PORT7 PORTF PORTG PORT)

[JPORTO
[C1PORT2
[C1PORT4
[C1PORTE
[C1PORTS
[ PORTA
[CPORTC
[PORTE

PORTG

[1PORT1

[1PORT3

[CIPORTS

Figure 4-18 Select Port selection

Navigate to the ‘Ports’ configure these four I/O lines and LCD control lines as shown in Figure 4-19, Figure
4-20, Figure 4-21 and Figure 4-22 below. Ensure that the ‘Output 1’ tick box is checked, except PG3. Select

‘PORT?7’ tab.

48k *5C_Tutorial. scfg &2
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Figure 4-19 Select PORT7 tab
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Select ‘PORTF’ tab.

ﬁf *SC_Tutorial.scfg &2 l
Software component configuration
Components az =] :"f:? ~  Configure
% o Port selection PORT7| PORTF |PORTG PORT)
type filter text
v (= Startup [ Apply to all
w [ Generic Unused In Out Pull-up  |CMOS output Output 1
& rbsp
w [ Drivers PEO
Int t
e E;'Eg::ﬁg_lcu ®Unused  Jin (O Out Pull-up CMOS output Output 1
w [= /O Ports
& Config_PORT PF1
w = Timers ®Unused  Jiin (D) Out Pull-up CMOS output Output 1
& Config_CMT2
& Config_CMTO PF2
_* Config CMT1 ®Unused Oin (O Out Pull-up CMOS output OQutput 1
= Middleware
Application
= App PF3
®Unused Oin O 0Out Pull-up CMOS output Output 1
PF4
@®Unused Oin (O Out Pull-up CMOS output Output 1
PF5
OUnused  Oln Pull-up | CMOS output v
Figure 4-20 Select PORTF tab
Select ‘PORTG’ tab.
i:°:} *SC_Tutorial.scfg &2 I
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- M'd:l Config CMT1 @Unused Oln OOut Pull-up CMOS output Output 1 High-drive output
iddleware
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Figure 4-21 Select PORTG tab
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Select ‘PORTJ’ tab.

& *SC_Tutorialscfg &2 l
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Figure 4-22 Select PORTJ tab
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4.4.5

SCI/SCIF Asynchronous Mode

In the RSK+RX65N-2MB SCI8 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as

shown in the schematic.

Click ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.
Select ‘SCI/SCIF Asynchronous Mode’ as shown in Figure 4-23 then click ‘Next'.

IE Mew Component

Software Component Selection

Select compenent from those available in list

Function |All

Type I Code Generator I

[m] >

i

Filter |

Components
B PWM Mode Timer
1 Real Time Clock

Version
1.1.0
1.0.0

Type
Code Generator

Code Generator

5 SCI/SCIF Asynchronous Mode Code Generator 1.0.0

£ 5C1/5CIF Clock Synchronous M...
# Single Scan Mode 51240

B Smart Card Interface Mode

<

1.0.0
1.1.0
1.0.0

Code Generator
Code Generator

Code Generator

Show only last version

Description

This software component provides configurations for SCI{SCIF) single(rmulti-
processor) asynchronous mode,

Download more software components

Configure general settings...

® < Back I Mext »

Finish |

Cancel

Figure 4-23 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as

shown in Figure 4-24 below.

6 New Component [m| X
Add new configuration for selected component |
SCI/SCIF Asynchronous Mode
Configuration name: | Config_5CI |
Work mode: Transmission ~
R . Transmission
esoures Reception
Transmission/Reception
Multi-processor Transmission
Multi-processor Reception
Multi-processor Transmission/Reception
® < Back Mext » Cancel

Figure 4-24 Select Work mode — Transmission/Reception
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In ‘Resource’, select ‘SCI8’ as shown in Figure 4-25 below.

6 New Component [m| X

Add new configuration for selected p t -Ha-

SCI/SCIF Asynchronous Mode

Configuration name: Config_5CI |

Work mode: Transmission/Reception ~

Resource: sCh ~

scn
SCI3 \

SCho
scnz2
SCiF
SCI5
sCI2
sCM
sClg
SCl6

® < Back Mext » Cancel

Figure 4-25 Select Resource — SCI8

Ensure that the ‘Configuration name’ is set to ‘Config_SCI8’ as shown in Figure 4-26 below then click ‘Finish’

Figure 4-26 Ensure Configuration name - Config_SCI8

6 New Component [m| X

Add new configuration for selected component -Ha-

SCI/SCIF Asynchronous Mode

Configuration name: I Config_SCI8 I
Work mode: Transmission/Reception ~
Resource: iSCI8 ~

® < Back et = Cancel
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Configure SCI8 as shown in Figure 4-27. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on

RXD8 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.
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Figure 4-27

Config_SCI8 setting
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4.4.6  SPIClock Synchronous Mode

In the RSK+RX65N-2MB SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as

shown in the schematic. Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type,
select ‘Code Generator’. Select ‘SPI Clock Synchronous Mode’ as shown in Figure 4-28 then click ‘Next'.

Ensure Operation, is setto '
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Software Component Selection
Select compenent from those available in list tl:r

Function |All ~
Type | Code Generator | v
Filter |

Components Type Version ()

E&S\ngle Scan Mode 512AD Code Generator 110

## Smart Card Interface Mode Code Generator 1.0.0

£ 5P| Clock Synchronous Mode Code Generator 1.0.0 |

B spl Operation Mode Code Generator 1.00

EE‘u’nltage Detection Circuit Code Generator 1.00

B AN b e Tienar L o 1inn N7

>

Show only last version

Description

This component provides clock synchronous operation of RSPI or 5CI (Simple 5PI bus). It
includes 4 transfer modes: Slave transmit/receive, Slave transmit, Master
transmit/receive and Master transmit.

Download more software components

Configure general settings...

@) <gack | Nea> |[ Emsh || Cancel

Figure 4-28 Select SPI Clock Synchronous Mode

Master transmit only’ as shown in Figure 4-29 below.

6 New Component [m| X

Add new configuration for selected component |

5PI Clock Synchronous Mode

Configuration name: | Config_SCI4 |

Operation: Master transmit only ~

Slave transmit/receive
Resource: .

Slave transmit only

Master transmit/receive

Master transmit only

Figure 4-29 Select Operation — Master Transmit
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In ‘Resource’, select ‘SCI6’ as shown in Figure 4-30 below.

IE Mew Component

Add new config for selected p t

5PI Clock Synchronous Mode

Configuration name: Config_SCI4

Operation: Master transmit only

Resource: SC14

sCl4
scn
R5PI12
sCho
RSPID
sCh2
RSPI1
sClo
sCIM
SCiF
sClg
sCI2

SCI5 |

® < Back Next =

Cancel

Figure 4-30 Select Resource — SCI6

Ensure that the ‘Configuration name’ is set to ‘Config_SCI6’ as shown in Figure 4-31 below then click ‘Finish’

IE MNew Component

Add new configuration for selected component

[m] X

8

5PI Clock Synchronous Mode

Configuration name: I Config_5CI6 I
Operation: Master transmit only ~
Resource: 5CI6 ~

® < Back Mext »

Cancel

Figure 4-31 Ensure Configuration name - Config_SCI6
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Configure SCI6 as shown in Figure 4-32. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 15000 kbps. All other settings remain at their defaults.

{55 *SC_Tuto rial.scfg £2

Software component configuration
Components = :%:5 -

-

type filter text

v (= Startup
w = Generic
& rbsp
v [= Drivers
v [ Interrupt
& Config_ICU
v [= |/O Ports
& Config_PORT
+ = Communications
& Config_SCI6
& Config_SCI3
~ [= Timers
& Config_CMT2
& Config_CMTD
& Config_CMT1
= Middleware
= Application

Transfer direction setting

() LSB-first

Data inversion setting
(@ MNormal

Transfer speed setting
Transfer clock

Bit rate

[JEnable modulation duty correction

Clock setting
[JEnable clock delay
Data handling setting

Transmit data handling
Interrupt setting
TXIE priority

TEIG pricrity (Group BLO)

Callback function setting

[ Transmission end

() Inverted

Internal clock (SCK6 pin functions as clock output pin)

15000 (kbps)  (Actual value: 15000,

[JEnable clock polarity inversion

Data handled in interrupt service routine

Level 13 (highest)

Level 13 (highest)

LV

Error: 0%)

Figure 4-32 Config_SCI6 setting
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4.4.7  Single Scan Mode S12AD

We will be using the S12AD on Single Scan Mode on the ANOOO input, which is connected to the RV1
potentiometer output on the RSK. The conversion start trigger will be via the pin connected to SW3. Click

‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’. Select
‘Single Scan Mode S12AD’ as shown in Figure 4-33 then click ‘Next'.

€ New Component m} x
Software Component Selection
Select component from those available in list tlj

Function | All ~
Type I Code Generator | ~
Fiter |
=

Components Type Version &

8 Real Time Clock Code Generator 1.0.0

B8 SCI/SCIF Asynchronous Mode Code Generator 1.00

B SCI/SCIF Clock Synchronous M., Code Generator 1.0.0

: £ Single Scan Mode 512AD Code Generator 1.1.0 |

B Smart Card Interface Mode Code Generator 1.00

B SPI Clock Synchronous Mode Code Generator 1.0.0 ©

Show only last version

Description

This software component provides single scan mode configurations for 12-Bit A/D Converter
which the analog inputs of up to 8 (unit 0) and 21 (unit 1) channels arbitrarily selected are
converted for only once in ascending channel order,

Download mere seftware components

Configure general settings...

® < Back I Mest = Il Einish | Cancel

Figure 4-33 Select Single Scan Mode S12AD

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘S12AD0’ as shown in Figure
4-34 below then click ‘Finish’.

€ New Component [m| X

Add new configuration for selected component |

Single Scan Mode 51240

Configuration name: | Config_S12AD0 ‘
Resource: 512AD0 ~
512AD1

@ = Back Next = Cancel

Figure 4-34 Select resource — S12ADO0
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Configure S12ADO0 as shown in Figure 4-35 and Figure 4-36. Ensure the ‘Analog input channel’ tick box for
ANOO0O is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’. All other settings

remain at their defaults.

8t *SC_Tutorial.scfg 22
Software component configuration

Components =]

!
=0

&

W

type filter text

v [= Startup
v [ Generic
& rhsp
w [= Drivers
v [= Interrupt
& Config_ICU
v = |/OPorts
& Config_PORT
w [= Communications
& Config_5CI6
& Config_5CI8
v = A/D Converter
& Config_5124D0
v = Timers
& Config_CMT2
& Config_CMTO
& Config_CMT1
== Middleware
(= Application

~  Configure

 Basic setting
Analog input mode setting
[ Double trigger mode

Analog input channel setting

ANODD ] an001 [ ano0z2 [ an003
[1an00s [1an006 [ anoo7

Conversion start trigger setting

Start trigger source

[ ano04

IWD conversion start trigger pin

Interrupt setting

Enable AD conversion end interrupt (512AD1) Priority Level 15 (highest)

« Advance setting

Add/Average AD value setting
[ an000 ANDDT ANDD2 ANDD3

AMNDDS AMNDDE AMNDO7T

Self diagnosis setting

ANODS

Mode Unused

ov

Disconnection detection assist setting
Charge setting Unused
2 ADCLK

Dedicated sample hold circuit channel setting

[ ano00 ANDD1 ANDDZ
Data registers setting
Data placement Right-alignment
Automatic clearing Disable automatic cleaning
Conversion resolution 12-bit accuracy
Addition/Average mode select Addition mode

Addition count 1-time

Window function setting
(® Disable () Enable

Figure 4-35 Config_S12ADO setting (1)
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Window A/B operation setting
[]Enable comparison window A

Window &/8 cormplex condition

A/D comparison A setting

Reference data O for comparison

Reference data 1 for comparison
Use comparator for ANOOD
Use comparator for ANDD1
Use comparator for ANODZ
Use comparator for ANOD3
Use comparator for ANON4
Use comparatar for ANDD3

Use comparater for ANDDG

Use comparater for ANDD7

A/D comparison B setting
Reference data O for comparison
Reference data 1 for comparison

Comparizson B channel

Input sampling time setting
Dedicated sarmple and hold circuit
AMNDDD/Self-diagnosis

ANOM

ANOOZ

ANOO3

ANOOY

ANOOS

ANO0G

ANOOT

Interrupt setting

Enable AD conversion compare interrupt A (512CMPAI)

Group BLT priority

[ Enable comparison window B

Window A comparison condition matched OR window B comparison condition matched

0

0

Reference data 0 » A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 > A/D-converted value

Reference data 0 > A/D-converted value

0
0
Unused

Reference data 0 > A/D-converted value

4 us)
0183 | ws
0.183 ius)
0.183 ius)
0.183 ius)
0.183 ius)
0.183 ius)
0.183 ius)
0.183 ius)

(Total conversion time: 0.767us)

Level 15 (highest)

Enable AD conversion compare interrupt B (512CMPEBI)

(Actual value: 4.0

(Actual value: 0.183)
(Actual walue: 0.183)
(Actual walue: 0.183)
(Actual walue: 0.183)
(Actual walue: 0.183)
(Actual walue: 0.183)
(Actual walue: 0.183)

(Actual value: 0.183)

Figure 4-36 Config_S12ADO setting (2)
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4.5 Pins configuration page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the

pins can be changed at Pins page.

LE‘:? *SC Tutorialscfg 52

Pin configuration
Hardware Resource

Type filter text

H B

S Al
#f Clock generator
£, Clock frequency accuracy measurement circuit
ﬁ-§ Buses
j;E EXDMA controller
# Interrupt controller unit

v . Multi-function timer pulse unit 3

MTUD
MTU1
MTUZ
MTU3
MTU4
MTUS
RATIIR

Pin Function  Pin Number

Overview | Board | Clocks Componentslnterrupts

Figure 4-37 Pin configuration page

45.1 Change pin assignment of a software component

To change the pin assignment of a software component in Pin Function list. Click 6% to change view to show
by Software Components.

5% *SC_Tutori alscfg &2

Pin configuration

Software Components

Type filter text

= 13

o

Figure 4-38 Change view to show by Software Components
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Select the Config_ICU of software component. In the Pin Function list -> Assignment column, change the pin
assignment IRQ13 to P05, IRQ11 to P03. Ensure the ‘Enable’ tick box of IRQ11 and IRQ13 are checked, as
shown in Figure 4-39.

8t *SC_Tutorial.scfg &2 = 0
Pin configuration Be
Software Components =] laz ;5% Pin Function ’,‘ | _§ﬂ| B e

Type filter text Type pin function
A -’#: r_bsp Enabled  Function Assignment Pin Number Direction Remarks
& rbsp O IRC0D Mot assigned Mot assigned Mone
w ﬁ: Compare Match Timer O IRCH Mot assigned Mot assigned MNone
&' Config_CMTO O IRC2 Mot assigned Mot assigned Mone
&' Config_CMT1 O IRC3 Mot assigned Mot assigned Mone
&' Config_CMT2 O IRC4 Mot assigned Mot assigned MNone
v ﬁ- Interrupt Controller 0O IROS Mot assigned Not assigned Mone
O IRQG Mot assigned Mot assigned MNone
v PE”:S O IRQT Mot assigned Mot assigned MNeone
@& Config_PORT O IROE Mot assigned Mot assigned MNeone
v ﬁ; SEI;’SCIFAS}rnchronousMode 0 IRQG Mot assigned Mot assigned Mone
& Config_5CI8 O IR0 Mot assigned Mot assigned MNone
w ﬁ; SEI Clock Synchronous Mode RQ11 1P02/IRO11/DAD | |
& Config_5CI6 O IRCQ12 Mot assigned Mot assigned MNone
v 5 Single Scan Mode 5124D Q12 [FossraizioAr ] 2 I
& Config_512AD0 O IRC14 Mot assigned Mot assigned Mone
O IRQ13 Mot assigned Mot assigned Mone
O NMI Mot assigned Mot assigned MNeone
< >

Pin Function  Pin Mumber

Overview | Board | Clocks | Components | Pins | Interrupts

Figure 4-39 Configure pin assighment - Config_ICU

Select the Config_SCI8 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD8 and TXD8 are checked and Assignment column of RXD8 is PJ1 and TXD8 is PJ2
as shown in Figure 4-40.

8t *5C_Tutorial.scfg &2 = O

Pin configuration (OR=]

Software Components B 1 &% Pin Function ~d | _§ﬂ| By

Type filter text Type pin function

v -’A‘: r_bsp Enabled  Function Assignment Pin Number Direction Remarks

W orbsp CT58# Mot assigned Mot assigned Mone
v i'!: Compare Match Timer RT58# Mot assigned Mot assigned MNene

' Config CMTO RXDE [PIH/VTIOCEA/RXD8/SMISO..] 59 I

' Config CMT1 SCK8 Not assigned Not assigned None

&' Config_CMT2 TXD8 [pr2/TxD8/SMOsIE/55DAS/S. ] 58 0
v ﬁ; Interrupt Controller

& Config_ICU
v ﬁ: Ports
& Config_PORT
v ‘,!.. SCI/SCIF Asynchronous Mode
w s 5PI Clock Synchronous Mode
& Config_SCI6
v /% Single Scan Mode 512AD
@& Config_512AD0

] [

Pin Function Pin Number

Owverview | Board | Clocks | Components | Pins | Interrupts

Figure 4-40 Configure pin assignment - Config_SCI8
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Select the Config_SCI6 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is P02, SMOSI6 is P00
as shown in Figure 4-41.

i:"-‘:} *SC_Tutorial.scfg &2 = 0

Pin configuration Gl &

Software Components = |4, & PinFunction =l | _§ﬂ| i 2

Type filter text Type pin functicn

e -"!_'- r_bsp Enabled  Function Assignment Pin Mumber Direction Remarks
' rbsp SCKG [Po2/TMCI/SCKE/IRO1D/A... | 6 [s]

ﬁ: Compare Match Timer SMIS06 Mot assigned Mot assigned Mone
& Config CMTO SMOsI6 [FOO/TMRIG TXD6/SMOSE/ .| & 1o

W' Config CMT1 SS6F Mot assigned Mot assigned Mone
&' Config_CMT2

v ﬁ; Interrupt Controller
& Config_ICU

_-,!; Ports
@& Config_PORT

_-,!; SCI/SCIF Asynchronous Mode
& Config_sCI8

w .-f!- SPI Clock Synchronous Mode
& Config_SCI6

2% Single Scan Mode S12AD
& Config_512AD0

<

ORIOE

<

<

<

Pin Function Pin Number

Overview | Board | Clocks | Compeonents | Pins | Interrupts

Figure 4-41 Configure pin assighment - Config_SCI6

Select the Config_S12ADO0 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of AN00O, AVCCO, AVSS0, ADTRGO#, VREFHO and VREFLO are checked and Assignment
column of ANOOO is P40, ADTRGO# is P07 as shown in Figure 4-42.

6t *SC_Tutorial.scfg &3 = 8
Pin configuration 4 &
Software Components B 13 sz | Pin Function -l | _gﬂ | By ey

Type filter text Type pin function
~ -"i'- r_bsp Enabled  Function Assignment Pin Number Direction Remarks
. 0 rbsp ] ADTRGO# [PO7/IRG15/ADTRGEE ] 176 I
V iy Compare Match Timer ANDDD P/ TR08/ANDDD 173 I
- Conffg_CMTD O ANODT Mot assigned Mat assigned Meone
- Conffg_CMT‘I | ANDOZ Mot assigned Mot assigned Mone
N u! Config CMT2 O ANOO3 Mot assigned Mat assigned Meone
i Inferrupt.Controller O ANDOS Mot assigned Mot assigned Mone
» i Config ICU O ANOOS Mot assigned Mat assigned Mone
¥ e PErts ) O ANOOE Mot assigned Mat assigned Mone
i Config PORT O AMNDOT Mot assigned Mot assigned Mone
v ﬁ; SCI/SCIF Asynchronous Mode AVCC [ ] 175 |
@& Config 5CI8 AVSSO VS50 1 I
v ﬁ; SPI Cleck Synchronous Mede VREFHO VREFHOD 174 |
@& Config 5C16 VREFLD [Rero ] 72 |
v & Single Scan Mode 512AD
& Config_512AD0
< >

Pin Function  Pin Number

Overview | Board | Clocks | Components | Pins | Interrupts

Figure 4-42 Configure pin assignment - Config_S12ADO0
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Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘felGenerate Code’ at location of Figure 4-43.

{84 5C_Tutorial.scfg 52 = (m]

Pin configuration

Figure 4-43 Generate Code Button

The Console pane should report ‘Code generation is successful’, as shown Figure 4-44 below.
&) Console 2 =% Bl E | — -

Smart Configurator Cutput

Ma4p@aeal: File generated:srcsmc_gen'\general\r_cg_dmac.h ~
Ma4ea0881: File generated:srci\smc_genigeneral\r_cg sci.h
Me42eeeel: File generated:srchsmc_geni\generallr_cg rspi.h
Ma4eaeeel: File generated:srchsmc_geni\general\r_cg ppg.h
Ma4ea0801: File generated:src\smc_geni\general\r_cg tmr.h
Ma4peaeal: File generated:srcismc_gen'\general\r_cg lvd.h
Me4peeeel: File generated:srcismc_gen\general\r_cg_dmac_user.c
Me4eepeel: File generated:srchsmc_geni\generallr_smc_entry.h
Ma4ea0801: File generated:src\smc_geni\general\r_cg_cmt.h
Ma4ea0801: File generated:src\smc_geni\general\r_cg crc.h
Ma4peaeal: File generated:srcismc_gen'\general\r_cg _doc.h
Me4peeeal: File generated:srcismc_gen\generallr_cg_poe.h
Me42eeeel: File generated:srchsmc_geni\generallr_cg riic.h
Ma4ea0801: File generated:src\smc_geni\general\r_cg rtc.h
Ma4p@aeal: File generated:srcsmc_gen\general\r_cg elc.h
MB4peaeal: File generated:srcismc_gen'\general\r_cg_bsc.h
Meseeeel2: File generated:srcsmc_gen\r_pincfghPin.h

Meseepel2: File generated:srchsmc_gen\r_pincfghiPin.c

Maseaeea2: File generated:src\smc_genhr_confighr_bsp_interrupt_config.h
MeeB@aea2: File generated:srcismc_gen'\general\r_smc_interrupt.c
MeeBeaea2: File generated:srcismc_gen'\general\r_smc_interrupt.h
Mpepepea: Code generation is successful

mazeaaesd: File modified:srchsmc_genr_config\r_bsp_config.h

3
4

I

h

Figure 4-44 Smart Configurator console

When code generation is executed, the startup files generated at the time of CS+ project creation are replaced
with those generated by Smart Configurator. Figure 4-45 the project tree after code generation. In the next
chapter, user code is added to these files, and SC_Tutorial is completed by adding a new source file to the
project.

Project Tree ax
: @ 38l@
=] . f; SC Tutorial (Project)”
R3F363MEDFC (Microcontroller)
:sl Smart Configurator (Design Tool)
Ay CC-RX (Build Tool)
2=, RX Simulator (Debug Tool)
Program Analyzer (Analyze Toel)

ﬂ"éuild tool generated files
& sCTutorial.c

5[ 1] Smart Configurator
o[ Config_cmTO

! Config_CMT1

| Config_CMT2

| Config_ICU

| Config_PORT

| Config_S12AD0
! Config_5CI6

| Config_SCI8

| general

\ r_bsp

i r_config
@1l r_pincfg

Figure 4-45 Smart Configurator folder structure
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5. Completing the Tutorial Project

5.1 Project Settings

e In the ‘Project Tree’' pane, select
‘CC-RX (Build Tool). The build
properties will appear in the main
window.

e CS+ creates a single build
configuration called ‘Default Build’ for
the project. This has standard code
optimisation turned on by default.

4, CC-RX Property
~ Build Mode
Build mode:
Change property value for all build modes at once
v CPU
Instruction set architecture
Uses floating-point operation instructions
Endian type for data
Rounding methed for floating-point constant operations
Handling of denormalized numbers in floating-point constants
Precision of the double type and long double type
Replaces the int type with the short type
Sign of the char type
Sign of the bit-field type
Selects the enumeration type size automatically
Order of bit-field members
Assumes the boundary alignment value for structure members is 1
Enables C++ exceptional handling function (try, catch and throw)
Enables the C++ exceptional handling function (dynamic_cast and typeid)
General registers used only in fast interrupt functions
Branch width size
Base register for ROM
Base register for RAM
Address value of base register that sets the address value

Build mode
Selects the build mode name to be used during build.

Defautt Build
No

RXw2 architecture(isa=nv2)

Yes(fpu)

Little-endian data{-endian=little)

round to nearest{+ound=nearest)
Handles as zeros(-denomalize=cff)
Handles in single precision{-dbl_size=4)
No

Handles as unsigned char(-unsigned_char)
Handles as unsigned{-unsigned_bitfield)
No

Allocates from right(bit_order=right)
Nol{-unpack)

Nol{noexception)

Noftti=off)

None{fint_register=0)

Compiles within 24 bits(-branch=24)
None

None

00000000

e Select the ‘Compile Options’ tab at
the bottom of the properties window
pane. Under ‘Language of the C
source file’ select ‘C99(-lang=c99)’
as shown opposite.

Property

A, CC-RX Property
~ Source
Language of the C source file
Language of the C++ source file
Additional include paths
System include paths
Include files at the head of compiling units
Macro definition
Invalidates the predefined macro
Enables information-level message output

Suppresses the number of information-level messages
level

Changes the warning-level m ges to information-level m

Permits comment (/* /) nesting

Changes the information-level messages to warning-level messages
Changes the information-level and warning-level messages to error-level mess: No

++{ang=cpp
Additional include paths[16]
System include paths[0]
Include files at the head of compiling units[0]
Macro defintion[0]

MNo(nomessage)

No
No

MNo(-comment=nonest)

e Select the ‘Link Options’ tab at the
bottom of the properties window

w Section
Section start address
The specified section that outputs externally defined symbols to the file
Section alignment

B_1.R_1B_ZR_2B.R.51.5//04,PResetPRG/OFFEQ0000C_1C_2C.Cs
The specified section that outputs extemally defined symbols ta the file[0]
Section alignment[0]

pane. Under ‘Section -> ROM to ROMtoRAMmapnedsemnm [
RAM mapped section’, add the three o
mappings as shown opposite.
e These settings are easily added by Text Edit x
clicking the button ‘..." and pasting —
the following text into the dialog: ;_R
D:1=F~!_‘I
D_2=R_2
D=R
D 1=R_1
D_2=R_2

e This ensures that the linker assigns
RAM rather than ROM addresses to
C variables. Click ‘OK’

Cancel Help
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e From the ‘Build’ menu, select ‘Build
Mode Settings...". Click ‘Duplicate’
and in the resulting ‘Character String
Input’ dialog, enter ‘Debug’ for the
name of the duplicate Build Mode.

j!l File

& s |[J H &
EeEeg 9
¢4 © 2@
A [
=| = sC Tutorial p| =
E .. 9% RSF365MEL ]
— Smart Con
N CC-RX (Bu E']
5 RX Simulat, <4
‘U Program A =

@3 SC_Tutorial - C5+ for CC - [Project Tree]

File Edit View Project |Build | Debug Tool Window Help

Build Project F7
Rebuild Project Shift+F7
Clean Project

Rapid Build

Update Dependencies

Build SC_Tutorial

Rebuild C_Tutorial

Clean SC_Tutorial

Update Dependencies of SC_Tutorial

M) Set Link Order of SC_Tutorial...
21 Open the Optimization Performance Comparison Tool for 5C_Tutorial...
¥ Stop Build Ctrl +F7
Ty Build Mode Settings...
1:_1 Batch Build...
T4 Build Option List

Build Mode Settings X

Selected build mode:

Build mode list:

Default Build Duplicate...
o

e The new ‘Debug’ Build Mode will be Property

added to the Build Mode list. Click
‘Close’.  Now, in the main CC-RX
Property  window, under the
‘Common Options’ tab, click on the
line containing ‘Build Mode’, click the
pull-down arrow and select ‘Debug’
from the pull-down'.

A, CC-RX Property
~ Build Mode
Build mode

v CPU

Change property value for all build modes at once

Instruction set architecture

Diefault Build

Diefault Build

e In the ‘Frequently Used Options (for
Compile)’ group, select  the
‘Optimization Level’ option and select
‘0’ from the pull-down. We have now
created a ‘Debug’ Build Mode with
no code optimisation and will be
using the Build Mode to create and
debug the project.

Property

“‘ CC-RX Property
» PICIPID

Output file type
Additional include paths

System include paths
Macro definition

o ow £

Optimization level

Optimization type
Outputs a source list file

~ DutputFile Typeand Path

Intermediate file output folder
Frequently Used Options(for Compile)

Outputs debugging information

Outputs additional information for inter-module optimization

« Frequently Used Options{for Assemble)

Execute Module{Load Module File)
“%BuildModeName %

Additional include paths[16]
System include paths[0]

Macro definition[0]

Yes(-debug)

2

Max(-optimize=max)
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e All of the sample code projects
contained in this RSK+ are
configured with three Build Modes;
‘DefaultBuild’, ‘Debug’ and ‘Release’.
‘Release’ is created in the same way
as above; by duplicating ‘Default
Build’. ‘Release’ Build Mode leaves
code optimisation turned on and
removes debug information from the
output file.

e To remove debug information from
the ‘Release’ Build Mode, in the ‘CC-
RX Property’ window, select the
‘Common Options’ tab at the bottom
of the window pane. For the
‘Outputs  debugging information’
option, select ‘No(-nodebug).

e Reset the Build Mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.

e From the menus, select ‘File -> Save
All' to save all project settings.

4 CC-RX Property
v Build Mode
Build mode
Change property value for all build modes at once
CPU
PIC/PID
Output File Type and Path
+ Frequently Used Options(for Compile)
Additional include paths
System include paths
Macro definition
Outputs debugging information
Optimization level
Outputs additional infermation for inter-module optimization
Optimization type
Outputs a source list file
Frequently Used Options{for Assemble)
+ Frequently Used Options(for Link)
Using libraries

Optimization type
Section start address
+ Frequently Used Options(for Hexx Output)

Release
No

Additional include paths[16]

System include paths[0]

Macro definition[0]

‘Yes(-debug)

2(-optimize=2)

No

Optimizes with emphasis on code size{size)
Mo{-nolistfile)

Using libraries[0]

Dutputs debugging information Yes (Outputs to the output file)-DEBug)

Yes (Outputs to the output file)-DEBug)
‘fes (Dutputs to <output file name:>.dba file)-SDebug
No{-MODEBug)

52 Additional Folders

e Before new source files are added
to the project, we will create two
additional folders in the CS+
Project Tree.

e In the Project Tree pane, right-click
the SC_Tutorial project and select
‘Add -> Add New Category’.

Project Tree . x

¢ © 2lE

-
L
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v
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wn
=
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E
=%
1%a)
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i
[ =
g
g8
s

Rebuild SC_Tutorial
Clean SC_Tutorial

=, R Simul
T) Program
-3l File

Open Folder with Explorer
Windows Explorer Menu

Add

-

,f; Add Subproject...

{4 SetSC_Tutorial as Active Project

Paste

Rename

%}l Property

Save Project and Development Tools as Package...

£ Add New Subproject...
Add File...

Add MNew File...
Add MNew Category

Cerl+V

I ]

e Rename the newly-created ‘New
Category’ folder to ‘C Source Files'.
Repeat these steps to create a new
category folder for ‘Dependencies’.

=-| i 5C Tutorial (Project)*

----- “\, CC-RX (Build Tool)
----- 2, R Simulator (Debug Tool)

=3 File

ﬂ SC_Tutorial.c
._]_ Smart Configurator

ﬂ Build tocl generated files

----- {E, R3F363MED=FC (Microcontroller)
----- E’;\I Smart Configurator (Design Tool)

----- f:’ Program Analyzer (Analyze Tool)
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5.3 Precautions on using Smart Configurator

When executing the build using Smart Configurator, the warning message shown in Figure 5-1 may be

displayed.

WIaE1100:Cannot find ~PResetPRE" specified in option “start™

WOEE 1100 Canmot find “CREINITY specified in option “start™]
WiaE1100:Cannat find “CHYTEL" specified in option “start”
WOEE 1100 Canmot find “PIRtPRGY specified in option “start™J
Renesaz Optimizing Linker Completed.

Figure 5-1: CS+ output window

It is a warning sentence that is displayed because there are unused sections, and there is no problem in

operation in SC_Tutorial created in this manual.
procedure below to make the setting.

If, do not want to display a warning message, follow the

« Double-click
display the build tool properties.

‘CC-RX(Build  Tool)’

to

Project Tree n

? © 3| [E

=-| 7% SC Tutorial (Project)*
{E R3F363MED%FC (Microcontroller)
"8 Smart Configurator (Design Tool)

-2, R¥ Simulator (Debug Toel)
}T:' Program Analyzer (Analyze Tool)

-7 File

« Select the 'Link Options' tab at the bottom

of the Properties screen.

« Section is set to the start address' of the

section.

Property

- X

#¢ CC-RX Property

a2 |2 |+

> Input

» Output

> List

> Optimization
- 5

Section alignment

Verify

>
>
» ROM to RAM mapped section
>
>

Section
e TR 7B 2R 2 BRSUSIE PResetPRG/IFFEDD .,

The specified section that cutputs externally defined symbels to the file  The specified section that outputs extemally defined symb

Section alignmert[0]

ROM to RAM mapped section[3]

« Overwrite the start address of the section

below.

B_1,R_1,B 2,R_2,B,R,SU,SI/04,C_1,C 2
,C,C$*,D*,W*,L,P*/OFFE00000,EXCEPTV
ECT/OFFFFFF80,RESETVECT/OFFFFFF

FC

Others
Property s
4, CC-RX Propety a |2 -+

5 Input

5 Qutput

» List

5 Optimization
w Section

Section alignment

Verify
Others

Section start address
The specified section that cutputs externzlly defined symbels to the file

>
>
> ROM to RAM mapped section
b
b

B_1.R_1.B_2.R_2.B.R.5U.51./04.C_1.C 2.C...

“The specified section that outputs extemally defined symb]
Section alignment[0]
ROM to RAM mapped section[3]
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54 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK+. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Locate the files ascii.h, r_okaya_lcd.h, ascii.c, and
r_okaya_lcd.c in this folder. Copy these files into the C:\Workspace\SC_Tutorial\src folder.

« Move the ‘SC_Tutorial.c’ file from [ ] B - | sClutorial
‘C:\Workspace\SC_Tutorial’ to LR fome | Share  View
'C:\Workspace\SC Tutorial\src|. &« v P » ThisPC » Local Disk (C:) » Workspace » SC_Tutorial
Name ) - Daten
7 Quick access R
Debug
1 This PC DefaultBuild
[ Desktop Release _A
- >
| Documents src
; Downloads j dbsct.c
J’ Music jhwsetup.c
o jintprg.c
= Pictures " iodefine.h
m Videos

\:] lowlvl.src

j lowsrc.c

j lowsrc.h

j resetprg.c

j shrk.c

1 shrk.h

\:] SC_Tutorial A% mtud

SC_Tutorial.c

3 5C_Tutorial. mtpj

‘s Local Disk (C:)

[_} Metwark

« Right-click on the ‘C Source Files’ folder and "“"’“ - ——
select ‘Add’ -> ‘Add File...".

-1 SC Tutorial (Project)*
o RSFS65NEDKFC (Microcontroller)
| Smart Configurator (Design Taol)
.y, CC-RX (Build Toal)
2% RX Simulater (Debug Tool)
. Program Analyzer (Analyze Tool)
=3 File
ﬂ Build tocl generated files
I_E Smart Configurator

I_ﬂ DEP‘Endanci Ll r|} AddFie.
Bl Open Folder with Explorer 1 Add New File...
El| Windows Explorer Menu ]l Add New Category
&l Remove from Project Shift+Del
4y Copy Cirl+C
[ Paste Ctrl+V
d# Rename F2
Property
« Select the files to be added (ascii.c, e s
r_okaya_lcd.c, SC_TutoriaI) from C: « v 4 || « Workspace » SCTutorial » src » v & Searchsrc o
\Workspace\SC_Tutorial\src. EEY DI B O e
Name
s Quick access
smc_gen
& ThispC ) esciie
B Desktop " r_okaya_lcd.c
[E Documents | SCTutorial.c
J Downloads
D Music
&) Pictures
H Videos
‘e Local Disk (C:)
¥ Network
< >
File name: | "SCTutorial.c” "ascii.c' "r_okaya_lcd.c” V| C sourcefile (*.c) ~
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o Similarly, add ‘ascii.h’ and ‘r_okaya_lcd.h’ to the |MEEEEEES
'Dependencies’ folder. € =2 v 4 [H o Worispace » SCTuorml > s1c > v|B] | Seorchre 2
Organize = Mew folder v @
) MName -
Note: Select the Header file (* .h; * hpp; * .inc). o Qi sccess ame_gen
[0 This PC Gllecin
[ Desktop ”j r_okaya_lcd.h
/] Documents
4 Downloads
J Music
=] Pictures
B videos
%5 Local Disk (C:)
¥ Network
< >
File name: |"r7ukayail(d.h" "ascii.h" v‘ IHeaderﬁIe (*.h; *.hpp; *.inc) VI
Cancel
» Make sure the project tree is the same as the FEEETEE it
screen shot. t © 2@
=-|f} SC Tutorial (Project)*
. J¥ RSFSESNEDXFC (Microcontroller)
Smart Configurator (Design Toel)
4y, CC-RX (Build Tool)
2 RX Simulator (Debug Tool)
; J:) Program Analyzer (Analyze Tool)
o
'EE Build teol generated files
I_E Smart Configurator
EI[E C Source Files
| ascii.c
iﬂ r_okaya_lcd.c
¢ ..&] SC_Tutorialc
EI[E Dependencies
----- "J ascii.h
o i'J r_okaya_lcd.h
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Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user needs to subsequently change any of the Smart Configurator-generated code.

In the CS+ Project Tree, expand the ‘Smart Configurator/general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for function. Do not edit comment generated here */

#define TRUE (¢H)
#define FALSE ()

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, expand the ‘C Source Files’ folder and open the file ‘'SC_Tutorial.c’ by double-clicking
on it. Add header files above the ‘main’ function as shown below.

#include "r_smc_entry.h"
#include "r_okaya lcd.h"
#include "r_cg userdefine.h"

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main(void)

{
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSK+RX65N-2MB ");
R_LCD_Display(1l, (uint8_t *)" Tutorial ");
R_LCD _Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
{
}

}
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5.4.1  SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in 84.4.6. In
the CS+ Project Tree, expand the ‘Smart Configurator/Config_SCI6’ and open the file ‘Config_SCI6.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD_STATUS R_SCI6_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* End user code. Do not edit comment generated here */
Now, open the Config_SCI6_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:

static void r_Config_SCI16_callback_transmitend(void)
/* Start user code for r_Config_SCI6_callback_transmitend. Do not edit comment generated here */
sci6_txdone = TRUE;

/* End user code. Do not edit comment generated here */

¥
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_SCI16_SPIMasterTransmit
Description : This function sends SPI6 data to slave device.
Arguments : tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

O X Ok X X X XN

MD_STATUS R_SCI6_SPIMasterTransmit (uint8_t * const tx_buf,
const uintl6_t tx_num)
{

MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
sci6_txdone = FALSE;

/* Send the data using the API */
status = R_Config_SCI6_SPl_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci6_txdone)

/* Wait */
}

return (status);

}

/
* End of function R_SCI6_SPIMasterTransmit

/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.4.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in 84.4.2. In the CS+ Project Tree,
expand the ‘Smart Configurator\Config_ CMTO\Config_CMTO.h’ and insert the following code in the user area
for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */

static volatile uint8_t one_ms_delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config_ CMTO_cmiO_interrupt function and insert the following line in the user code area:

static void r_Config_CMTO_cmiO_interrupt(void)

{
/* Start user code for r_Config_CMTO_cmiO_interrupt. Do not edit comment generated here */
one_ms_delay_complete = TRUE;
/* End user code. Do not edit comment generated here */

¥

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_CMT_MsDelay

Description : Uses CMTO to wait for a specified number of milliseconds
Arguments : uintl6_t millisecs, number of milliseconds to wait
Return Value : None

o o XN

void R_CMT_MsDelay (const uintl6_t millisec)
uintl6é_t ms_count = O;

do
{
R_Config_CMTO_Start();
while (FALSE == one_ms_delay_complete)

{
/* Wait */

(o)

R_Config_CMTO_Stop();
one_ms_delay complete = FALSE;
ms_count++;
3} while (ms_count < millisec);
}
/
End of function R_CMT_MsDelay

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSK+RX65N-
2MB Tutorial Press Any Switch’ on 3 lines in the LCD display.
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5.5 Switch Code Integration

API functions for user switch control are provided with the RSK+. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Locate the files rskrx65n2mbdef.h, r_rsk_switch.h and
r_rsk_switch.c in this folder. Copy these files into the C:\Workspace\SC_Tutorial\src folder. Add these three
files into the project in the same way as the LCD files.

The switch code uses interrupt code in the files Config_ICU.c, Config_ICU_user.c and Config_ICU.h and timer
code in the files Config_ICU.c, Config_ICU_user.c, Config_ CMT1.h, Config_ CMT1.c, Config CMT1_user.c,
Config_ CMT2.h, Config_ CMT2.c, and Config_ CMT2 user.c, as described in 84.4.2 and 84.4.3. It is
necessary to provide additional user code in these files to implement the switch press/release detection and
de-bouncing required by the API functions in r_rsk_switch.c.

551 Interrupt Code

In the CS+ Project Tree, expand the ‘Smart Configurator/Config_ICU’ folder and open the file ‘Config_ICU.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */

Now, open the Config_ICU.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_ICU_IRQIsFallingEdge

* Description : This function returns 1 if the specified ICU_IRQ is set to
* falling edge triggered, otherwise O.

* Arguments : uint8_t irg_no

* Return Value : 1 if falling edge triggered, O if not

uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
uint8_t falling_edge trig = 0x0;
if (ICU.IRQCR[Lirg_no]-BYTE & _04_ICU_IRQ_EDGE_FALLING)

falling_edge_trig = 1;
¥

return (falling_edge_trig);

}

/
* End of function R_ICU_IRQIsFallingEdge
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/
* Function Name: R_ICU_IRQSetFallingEdge
* Description : This function sets/clears the falling edge trigger for the
* specified ICU_IRQ.
* Arguments : uint8_t irg_no
* uint8_t set_T _edge, 1 if setting falling edge triggered, O if
* clearing
* Return Value : None
/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_t set_f_edge)
ifT (1 == set_T _edge)
ICU. IRQCRLirg_no].BYTE |= _04_ICU_IRQ_EDGE_FALLING;
}
else
ICU.IRQCR[Lirg_no] -BYTE &= (uint8_t) ~_04_ICU_IRQ_EDGE_FALLING;
3
/
* End of function R_ICU_IRQSetFallingEdge
/
/
* Function Name: R_ICU_IRQSetRisingEdge
* Description : This function sets/clear the rising edge trigger for the
* specified ICU_IRQ.
* Arguments : uint8_t irg_no
* uint8_t set_r_edge, 1 if setting rising edge triggered, O if
* clearing
* Return Value : None
/
void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
if (1 == set_r_edge)
ICU. IRQCR[Lirg_no].BYTE |= _08_ICU_IRQ_EDGE_RISING;
}
else
ICU. IRQCR[Lirg_no].BYTE &= (uint8_t) ~_08_ICU_IRQ_EDGE_RISING;
}
3
/
* End of function R_ICU_IRQSetRisingEdge
/

/* End user code. Do not edit comment generated here */
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Open the Config_ICU_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irgll_interrupt:

/* Start user code for r_Config_ICU_ irqll_interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R_SWITCH_IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg13_interrupt:

/* Start user code for r_Config_ICU_irql3_interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R_SWITCH_IsrCallback2();

/* End user code. Do not edit comment generated here */
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55.2 De-bounce Timer Code

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT1’ folder and open the ‘Config_ CMT1_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "'r_rsk _switch.h"

/* End user code. Do not edit comment generated here */

In the ‘Config_ CMT1_user.c’ file insert the following code in the user code area inside the function
r_Config_ CMT1_cmil_interrupt:

/* Start user code for r_Config_CMT1 cmil_interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R_Config_CMT1_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT2’ folder and open the ‘Config_ CMT2_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Open the ‘Config_ CMT2_user.c’ file and insert the following code in the user code area inside the function
r_Config_ CMT2_cmi2_interrupt:

/* Start user code for r_Config_CMT2_cmi2_interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R_Config_CMT2_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();

/* End user code. Do not edit comment generated here */
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553 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 84.4.7 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */

#define TRUE (¢D)
#define FALSE )

extern volatile uint8_t g_adc_trigger;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘C Source Files’ folder and Open the file ‘SC_Tutorial.c’ and add the
highlighted code, resulting in the code shown below:

#include "r_smc_entry.h"
#include "r_okaya lcd.h"
#include "r_cg_userdefine._h"
#include "Config_S12ADO.h"
#include "'r_rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* Prototype declaration for cb_switch_press */
static void cb_switch_press (void);

/* Prototype declaration for get_adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd_display_adc */
static void lcd_display adc (const uintl6_t adc_result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the

code shown below:

void main(void)

{
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX65N-2MB "*);
R_LCD_Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_Config_S12AD0_Start();
while (1U)
{
uintlé_t adc_result;
/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
iT (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else iIf (TRUE == g_adc_complete)
{
/* Get the result of the A/D conversion */
R_Config_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_complete = FALSE;
by
else
/* do nothing */
by
3
}

Then add the definition for the switch call-back, get_adc and Icd_display_adc functions adding at the below of

the main function, as shown below:

/
* Function Name : cb_switch_press
* Description . Switch press callback function. Sets g_adc_trigger flag.
* Argument I none
* Return value : none
/

static void cb_switch_press (void)
{

/* Check if switch 1 or 2 was pressed */

ifT (g_switch_flag & (SWITCHPRESS_ 1 | SWITCHPRESS_2))

{
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/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0x0;

¥
ks
/
* End of function cb_switch_press
/
/
* Function Name : get_adc
* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.
* Argument I none
* Return value : uintl6_t adc value
/
static uintl6é_t get _adc (void)
{
/* A variable to retrieve the adc result */
uintl6_t adc_result;
/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_Config_S12AD0_Stop();
/* Start a conversion */
R_S12ADO_SWTriggerStart();
/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)
/* Wait */
3
/* Stop conversion */
R_S12ADO_SWTriggerStop();
/* Clear ADC flag */
g_adc_complete = FALSE;
R_Config_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);
/* Set AD conversion start trigger source back to ADTRGOn pin */
R_Config_S12AD0_Start();
return (adc_result);
ks
/
* End of function get_adc
/
/
* Function Name : lcd_display_adc
* Description : Converts adc result to a string and displays
* it on the LCD panel.
* Argument : uintl6é_t adc result
* Return value : none
/

static void lcd_display_adc (const uintl6_t adc_result)

/* Declare a temporary variable */
uint8_t a;

/* Declare temporary character string */
char Icd_buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t)((adc_result & O0xO0F00) >> 8);

Icd_buffer[6] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)((adc_result & 0x00F0) >> 4);
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lcd_buffer[7] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (uint8_t)(adc_result & 0x000F);
Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD Display(3, (uint8_t *)lcd_buffer);

NS

End of function lcd_display_adc

In the Project Tree, expand the ‘Smart Configurator\Config_S12AD0’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R_S12ADO_SWTriggerStart(void);
void R_S12ADO_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_S12ADO0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_S12ADO_SWTriggerStart

Description : This function starts the ADO converter.
Arguments : None

Return Value : None

O X XN

void R_S12ADO_SWTriggerStart(void)

IR(PERIB, INTB186) = OU;
IEN(PERIB, INTB186) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;

}

/
End of function R_S12AD0 SWTriggerStart

Function Name: R_S12ADO_SWTriggerStop

Description : This function stops the ADO converter.
Arguments : None

Return Value : None

o X XN

void R_S12ADO_SWTriggerStop(void)

S12AD.ADCSR.BIT.ADST = 0U;

IEN(PERIB, INTB186) = OU;

IR(PERIB, INTB186) = 0OU;
}

/
End of function R_S12ADO_SWTriggerStop

/* End user code. Do not edit comment generated here */
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Open the file Config_S12AD0_user.c and insert the following code in the user code area for global, resulting in
the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8_t g_adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0 _interrupt function, resulting in the
code shown below:

static void r_Config_S12ADO_interrupt(void)
/* Start user code for r_Config_S12ADO_interrupt. Do not edit comment generated here */
g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */
3
Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the SC_Tutorial to add the UART user code.
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5.6 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK+. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Locate the files r_rsk_debug.h and
r_rsk_debug.c in this folder. Copy these files into the C:\Workspace\SC_Tutorial\src folder. Add these two files
into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI8_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.7 UART Code Integration

5.7.1  SCI Code

In the CS+ Project Tree, expand the ‘Smart Configurator\Config_SCI8’ folder and open the file ‘Config_SCI8.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD_STATUS R_SCI8 AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI8 user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci8_ txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI8_callback_transmitend function:

static void r_Config_SCI8_callback_transmitend (void)

{
/* Start user code for r_Config_SCI8 callback_transmitend. Do not edit comment generated here */
sci8_txdone = TRUE;
/* End user code. Do not edit comment generated here */

¥

R20UT3891EG0100 Rev. 1.00 .zEN ESNS Page 56 of 69

May 31, 2017



RSK+RX65N-2MB 5. Completing the Tutorial Project

In the same file, insert the following code in the user code area inside the r_Config_SCI8 callback_receiveend

function:

static void r_Config_SCI8 callback_receiveend(void)

{
/* Start user code for r_Config_SCI8 callback_receiveend. Do not edit comment generated here */
/* Check the contents of g _rx char */
iIT ((Cc” == g_rx_char) || ("C" == g_rx_char))
{
g_adc_trigger = TRUE;
}
/* Set up SCI8 receive buffer and callback function again */
R_Config_SCI18_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* End user code. Do not edit comment generated here */
3

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI8 AsyncTransmit

Arguments : tx_buf -
transfer buffer pointer
t>x_num -
buffer size
Return Value : status -
MD_OK or MD_ARGERROR

Ok X ok X X Ok XN\

/
MD_STATUS R_SCI8_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
sci8_txdone = FALSE;

/* Send the data using the API */
status = R_Config_SCI8 Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci8_txdone)

/* Wait */

return (status);

}

/
* End of function R_SCI8_ AsyncTransmit

Description : This function sends SCI8 data and waits for the transmit end flag.
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5.7.2 Main UART code

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to above the ‘main’ function:

#include "r_smc_entry.h"
#include "r_okaya_lcd.h"
#include "r_cg_userdefine._h"
#include "Config_S12ADO.h"
#include "'r_rsk switch.h"
#include "r_rsk_debug.h"
#include "Config_SCI8.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* Prototype declaration for cb_switch_press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd_display_adc */
static void lcd_display_adc (const uintl6_t adc_result);

/* Prototype declaration for uart_display_adc */
static void uart_display_adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:

void main(void)

{
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)' RSK+RX65N-2MB "');
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD _Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_Config_S12AD0_Start();
/* Set up SCI8 receive buffer and callback function */
R_Config_SCI18_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI8 operations */
R_Config_SCI18_Start();
while (1U)
{
uintl6é_t adc_result;
/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count */
iT (16 == (++adc_count))
adc_count = 0;
by
/* Send the result to the UART */
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}
}

uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{
/* Get the result of the A/D conversion */
R_Config_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == (++adc_count))
{

adc_count = 0;

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
3

else

/* do nothing */
¥

Then, add the following function definition in the end of the file:

FoX X X XN

Description

Function Name : uart_display_adc
: Converts adc result to a string and sends it to the UARTL.
Argument : uint8_t : adc_count

uintl6_t: adc result

Return value : none

static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)

{

/* Declare a temporary variable */
char a;

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: »xxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char)((adc_result & 0x0F00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char)((adc_result & 0Ox00F0) >> 4);

uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a =

(char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R_DEBUG_Print(uart_buffer);

}

/

/

* End of function uart_display_adc

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
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The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM & LPT)'
as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI8 (see §4.4.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the SCI8. Return to this point in the SC_Tutorial to add the LED user code.

5.8 LED Code Integration

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to the above the ‘main’ function:

#include "r_smc_entry.h"
#include "r_okaya_lcd.h"
#include "r_cg_userdefine._h"
#include "Config_S12ADO.h"
#include "'r_rsk switch.h"
#include "r_rsk_debug.h"
#include "Config_SCI8_h"
#include "rskrx65n2mbdef.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* Prototype declaration for cb_switch_press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd_display_adc */
static void lcd_display_adc (const uintl6_t adc_result);

/* Prototype declaration for uart_display_adc */
static void uart_display_adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init();
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSK+RX65N-2MB "");
R_LCD_Display(1, (uint8_t *)*" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_Config_S12AD0_Start();
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/* Set up SCI8 receive buffer and callback function */
R_Config_SCI8_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* Enable SCI8 operations */
R_Config_SCI8_Start();

while (1U)
uintl6é_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == (++adc_count))

adc_count = 0;
led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */

g_adc_trigger = FALSE;

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g_adc_complete)

{
/* Get the result of the A/D conversion */
R_Config_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count and display using the LEDs */
if (16 == (++adc_count))
{

adc_count = 0;

3
led_display_count(adc_count);
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */
g_adc_complete = FALSE;

¥

else
/* do nothing */

¥

3
3
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Then, add the following function definition in the user code area at the end of the file:

/
* Function Name : led_display_count
* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument I uint8_t count
* Return value : none
/
static void led_display_count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8_t)((count & 0x01) ? LED_ON : LED_OFF);
LED1 = (uint8_t)((count & 0x02) ? LED_ON : LED_OFF);
LED2 = (uint8_t)((count & 0x04) ? LED_ON : LED_OFF);
LED3 = (uint8_t)((count & 0x08) ? LED_ON : LED_OFF);
by
/
* End of function led_display_count
/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now
the LEDs will display the adc_count in binary form.
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6.

Debugging the Project

In the ‘Project Tree’ pane, right-click the
‘RX Simulator (Debug Tool)'.  Select
‘Using Debug Tool -> RX E2 Lite'.

Project Tree

) © 8@

E|,_§ SC Tutorial (Project)”

A, CC-RX (Build Tool)

.Y Program Analyze

R R Simulator (Debun Tool

{E, R3F565MED®FC (Microcontroller)
=~] Smart Cenfigurater (Design Tool)

Using Debug Tool

-

- File

- F] Build tool ge

Property

R¥ E2 Lite

[ ] Smart Configurator
[ C SourceFiles
t.[ ]l Dependencies

RX E1(Serial)
RX E10TAG)

RX E20(Serial)
RX E20(JTAG)

RX Simulator

Double-click ‘RX E2 Lite (Debug Tool)’ to
display the debugger tool properties.
Under ‘Clock’, change the main clock
frequency to 24 MHz, Communications
method ‘JTAG’ and operating frequency to
120MHz.’

All other settings can remain at their
defaults.

7 Property

Size of internal ROM[KBytes]
Size of internal RAM[KEytes]

w Clock
Main clock source
Main clock frequency[MHz]
Operating frequency[MHz]

v Connection with Emulator
Emulator serial MNo.
v Connection with Target Board

Communications method

JTAG clock[MHz]

Size of DataFlash memory[KBytes]

Faower target from the emulator. (MAX 200md)

Allow changing of the clock source on writing internal flash memory Mo

No
JTAG
6.00

Connect the E2 Lite to the PC and the
RSK+ E1/E2 Lite connector. Connect the
Pmod LCD to the PMOD1 connector.

Connect the center positive +5V PSU to
the PWR connector on the RSK+ and
apply power.

From the ‘Debug’ menu select ‘Download’
to start the debug session and download
code to the target.
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7. Running the Smart Configurator Tutorial

7.1 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

®
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8. Additional Information

Technical Support

For details on how to use CS+, refer to the help
file by opening CS+, then selecting Help > Help
Contents from the menu bar.

Tocl Window KIp‘
) O | g |® Help
m@+ Cpen Help for Start Panel F1
b - How to Access Help 2
@L @q Cne Point Advice...
Le B Tuterial
@] Browse Renesas Electronics Micrecontrollers Web
_é‘ Privacy Settings...

f Cre

Detail Version Information...

Check for Updates...

About...

For information about the RX65N group microcontroller refer to the RX65N Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:

https://lwww.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe Limited.

© 2017 Renesas Electronics Europe Limited. All rights reserved.
© 2017 Renesas Electronics Corporation. All rights reserved.
© 2017 Renesas System Design Co., Ltd. All rights reserved.
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